LENESANS Release Note

RZ/T2L Group
ENCOUT sample program

Summary
This document describes the RZ/T2L encoder divided-output (ENCOUT) module sample program package.

Functionality Checked Device
RSK+RZT2L Board (RTK9RZT2L0OC00000BJ)
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RZ/T2L Group

ENCOUT sample program

1. Package Contents

This package contains the following contents.
The RZ/T2L has one unit of ENCOUT module. Number of output channels supported by this sample program

is one.

1.1 Software

e Source Code
No. name Version number
1 RZ/T2L ENCOUT sample program 20
1.2 Documents
No. Document name Version File name
1 RZ/T2L Group ENCOUT sample | 2.00 (j) r11an0727j0200-rzt2l.pdf
program Release Note (e) r11an0727ej0200-rzt2l.pdf (this document)
2 RZ/T2L Group ENCOUT sample | 2.00 (j) r11an0726j0200-rzt2l-encout.pdf
program Application Note (e) r11an0726€j0200-rzt2I-encout.pdf
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ENCOUT sample program

2. File Structure

The file structure and contents of this package are detailed below.

Top
— r11an0727jj0200-rzt2l.pdf
F— r11an0727ej0200-rzt2l.pdf
L— workspace

— Software
\ — iccarm
.

| ——gcc

L— RZ_T2L_encout.zip : RZ/T2L ENCOUT sample program set (IAR)

| L— RZ_T2L_encout.zip : RZ/T2L ENCOUT sample program set (e? studio)

L— Documents

— r11an0726jj0200-rzt2l-encout.pdf
— r11an0726€j0200-rzt2l-encout.pdf

The file structure of the RZ_T2L _encout.zip is shown below.

Top folder
— configuration.xml

: FSP Configuration Data

— ( Build Tool Dependent Environment Files )

L—src

F— hal_entry.c
— encout_main.c
— siochar.c
— siorw.c
— sio_char.h
L—drv
—src
\ L—r_encout_rzt2.c
—inc
— iodefine_encout.h
F—r_encout_rzt2_config.h
L—r_encout_rzt2_if.h

: ENCOUT sample program
: ENCOUT sample program
: SCI_UART sample program
: SCI_UART sample program
: SCI_UART sample program

: ENCOUT driver file
: ENCOUT register definition file

: ENCOUT driver file
: ENCOUT driver file

R11AN0727EJ0200 Rev.2.00
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3. About ENCOUT Sample Program

This section contains information necessary to use the complete set of ENCOUT sample program.

3.1 Software Information
3.1.1 Base OS

This sample program is OS-independent.

3.1.2 Memory Size

Memory size used by this sample program and ENCOUT driver is shown in following table. This table does
not include memory size used by Flexible Software Package or C language libraries of the compiler.

ltems Memory Size

EWARM e? studio

[kBytes] [kBytes]
ENCOUT driver Code 0.7 0.7
Data (with initial value) 0.0 0.0
Data (without initial value) 0.0 0.0
Constant Data 0.0 0.0
Sample program Code 1.2 14
Data (with initial value) 0.0 0.0
Data (without initial value) 0.0 0.0
Constant Data 0.2 0.2
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3.2 Hardware Information
3.2.1 Device
RzZ/T2L

3.2.2 Target Board

(1) Board Name
RSK+RZT2L (RTK9RZT2L0C00000BJ)

(2) Setting of the Target Board

The target board configuration is as follows.

SW4-1: ON, SW4-2: ON, SW4-3: OFF
SW4-4: OFF

SW4-5: ON

SW4-6: ON

SW4-7: OFF

SW3-4: OFF *

SW1: Prohibit pressing *

Note: The DIP switch SW3-4 and push-button switch SW1 are connected to output pins used by this
sample program. Do not switch them on, while this sample program is running.

(3) Used Pins of the Target Board

The correspondence between the pin used by the ENCOUT and the pin header of the target board is as

follows. Only channel 0 is available.

Channel Pin name Pin header Input/Output Description
Channel 0 POUTA JA1-A #23 Output Phase A output pin
POUTB JAT-A#17 Output Phase B output pin
POUTZ JA1-A#18 Output Phase Z output pin

R11AN0727EJ0200 Rev.2.00
May 31.24
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ENCOUT sample program

3.3 Procedures on Development Environments

3.3.1

3.3.2
(1)

Preparation before Executing the Sample Program
This sample program communicates with a PC. The USB connection terminal on the target board is CN16.

The terminal software of the host PC is set as shown in the following table.

Function

Setting

Communication method

Asynchronous serial transm

it/receive

Order of transmission / reception

LSB first

Transfer rate 19200 bps
Character length 8 bits
Stop bit length 1 bit
Parity function None
Hardware flow control None

EWARM from IAR Systems

Build Environment

IAR Embedded Workbench for ARM v9.50.1
RENESAS RZ/T2 Flexible Software Package v2.0.0

()
IAR

®)

Execution Environment ICE

I-jet

Build Procedure for Sample Programs

The build procedure for the sample program is as follows.

1
2
3
4
5

Note:

Copy the extracted source files to the desired location.

Activate EWARM.

Select [File] menu -> [Open Workspace].
Open the extracted source file RZ_T2L_encout.eww.
Start the FSP Smart Configurator from the [Tools] menu of the EWARM IDE. *

The following procedure adds the activation of the FSP Smart Configurator to the [Tools] menu of the
EWARM IDE. Select [Tools] menu -> [Tool Configuration] in the EWARM IDE. Select the [New]
button, specify a table string in each field, and press [OK].

Field String
Menu text RZ Smart Configurator
command $RASC_EXE_PATHS$
argument --compiler IAR configuration.xml

Initial directory

$PROJ_DIR$

String for the command is variable holding the path of the Smart Configurator execution file, rasc.exe.
You can also start the FSP Smart Configurator directly from the command prompt by specifying the

folder where it is installed.

R11AN0727EJ0200 Rev.2.00
May 31.24
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RZ/T2L Group

ENCOUT sample program

6

In the FSP Configuration pane of the Smart Configurator, click Generate Project Content. The rzt,
rzt_cfg, rzt_gen, script and .setting folders will be generated.

File Window Run Help
% [RZT2L_ENCOUT _release_chk] FSP Configuration

Summary
Project Summary
Board: RSK+RZT2L (RAM execution without flash memory)
Device: ROADTGO7T4MO4GBG

FSP Version: 2.0.0
Project Type: Flat

Selected software components

Board Support Package Common Files

Memory Config Checking

/O Port

Arm CMSIS Version 5 - Core

Board support package for RO9AQTGO74MO4GBG

LEO

Summary| BSP| Clocks| Pins Interrupts Event Links Stacks Components:
[ Properties (2. Problems *E
Property Value

Location: C:1_Prog/Work/Work_C/Work_EWA_950_1/RZT2L_|

ﬁ C¥1_Prog¥Work¥Work_C¥Work_EWA_950_1¥R7T2L_ENCOUT_release_chk - FSP Smart Configurator

= o
g B
Generate Project Content

) A~
RENESAS

ENCOUT _release_chk o=

v2.0.0

v2.00

v2.00
v5.7.0+renesas.2.f5p.2.0.0
v2.00 ¥

§ = 0 @ Console
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FSP Visualization =0
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Mo consoles to display at this time.

7 When project generation is complete, close the Smart Configurator.
8 Select [Rebuild ALL] from the [Project] menu of EWARM.
The file Debug\Exe\RZ_T2L_encout.out is generated.

(4) Sample Program Execution Procedure
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After executing the "build procedure", connect the target board and debugger correctly, and perform the

following operations.

1 Select [Project] menu -> [Download and Debug].

2 Select [Debug] menu -> [Execute].

(5) Execution Result of the Sample Program

The ENCOUT driver version is displayed in the terminal software window by executing this sample
program. Additionally, Phase ABZ signals shown in the RZ/T2L Group ENCOUT Sample Program
Application Note “4.8.9 Execution Result of the Sample Program” are outputted to the pin headers shown

in “3.2.2(3) Used Pin”.
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3.3.3 e? studio from RENESAS
(1) Build Environment

RENESAS e? studio 2024-01.1
GNU ARM Embedded Toolchain 12.2.1.arm-12-24
RENESAS RZ/T2 Flexible Software Package v2.0.0

(2) Execution Environment ICE
SEGGER J-Link v7.94h

(3) Build Procedure of the Sample Program
The procedure for building the sample program is as follows.

1 Copy the expanded source file to any location.

2 After launching e? studio and moving to the workspace, click the [File] menu -> [Import] and select
Existing project to workspace and click [Next].

3 On the project import screen, select the folder where the sample program was expanded as the root
directory.

4 Select a project, check Copy Project to Workspace, and click [Finish].

5 Double-click the configuration.xml in the Project Explorer pane of e? studio to open it.

ﬁ RZTZL_ENCOUT _release_chk - &® studio — O *
File Edit Source Refactor Nawvigate Search Project RenesasViews Run Window Help

Br& - o Q- Q | Eoc
{5 Project Explorer e = 0O || g% Outline X = 0|

~ 15 RZ_T2L_encout [Debug There is no active editor

n Includes that provides an outline.

& src
RZ_TZ2L_encout.elfjlink
X RZ_T2L encoutelflaunch

7) Developer Assistance

* Problems » | B Console| [T} Properties| @ Av¥-k- 7591~ L} A¥-F-¥Za7L i
0 emors, 11 warnings, 0 others
Description Resource Path Location Type

5 Wamings (11 items)

o¢ configurationxml - RZ_T2L_encout

R11ANO727EJ0200 Rev.2.00 Page 8 of 10
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6 Click Generate Project Content in the FSP Configuration pane of e2 studio.
The rzt, rzt_cfg, rzt_gen, script, .settings folders are generated.

a RZT2L_ENCOUT release_chk - RZ_T2L_encout/configuration.xml - & studio - O x
File Edit Source Refactor Navigate Search Project RenesasViews Run Window Help

- o Q- Q |
(1 Project Explorer X = O | {5 [RZ_T2L encout] FSP Configuration X BF Outline X =0|a

= & Summal 0 There is no active editor that provides e/

v 5 RZ_T2L_encout 1y Generate Project Content an outline.

¥ Includes .

8 Project Summary 2 ~

RENESAS

42 configurationxmi

Board: RSK+RZT2L (RAM execution without flash memoary)
RZ_T2L_encout.elfjlink

Device: ROA07GO74MO4GBG

X RZ_T2L_encoutelflaunch " .
Toolchain: GCC for Renesas RZ

7) Developer Assistance Toolchain
Version: 12.2.1.am-12-24
FSP Version: 200
Project Type: Flat
Location: C:/1_Prog/Work/Work_C/Work_E25_RZ..._ENCOUT_release_chk/RZ_T2L_encout ==

Selected software ponents

Board Support Package Common Files v2.0.0
Memory Config Checking v2.0.0
10 Port v2.0.0 b

o| 2[4

Summary BSP Clocks | Pins | Interrupts | Event Links Stacks Components

* Problems x [ Console Properties @ ZV-k- 7394 | L) 29-+-3227 0 § = 0O
0 errors, 11 wamings, 47 others
Description Resource Path Location Type
% Wamings (11 items)
< > i Infos (47 items)

7 Select [Project] menu -> [Build All]
The Debug\RZ_T2L_encout.elf file is generated.

(4) Execution Procedure of the Sample Program

After executing the "build procedure", connect the target board and debugger correctly, and perform the
following operations.

1 Select [Run] menu -> [Debug As] -> [Renesas GDB Hardware Debugging].

2 Click [Debug] to start downloading to internal RAM.
3 Click [Run] menu -> [Resume] to run the sample program.

(5) Execution Result of the Sample Program

The ENCOUT driver version is displayed in the terminal software window by executing this sample
program. Additionally, Phase ABZ signals shown in the RZ/T2L Group ENCOUT Sample Program
Application Note “4.8.9 Execution Result of the Sample Program” are outputted to the pin headers shown
in “3.2.2(3) Used Pin”.
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Revision History

Rev.

Date

Description

Page

Summary

0.80

Jan 20.23

First Edition issued.

1.00

Mar 31.23

Change description by using RZ/T2 FSP v1.2.0
(Version number of documents, target board name, build
environment, and figures are updated.)

May 31.23

Appended section 3.1.2 for memory size information.
Updated the release note version number.

2.00

May 31.24

NN =
wlw &

Updated revisions of the application note and the release note.
Updated sample program version to 2.0 (Supported FSP v2.0.0)

Updated file structure. (Removed RZ/T2L Pin Configuration data
from zip file.)

Updated memory size information.
Updated description of the board name.
Updated build environment for FSP v2.0.0. Figures are replaced.
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General Precautions in the Handling of Microprocessing Unit and Microcontroller
Unit Products

The following usage notes are applicable to all Microprocessing unit and Microcontroller unit products from Renesas. For detailed usage notes on the
products covered by this document, refer to the relevant sections of the document as well as any technical updates that have been issued for the products.
1. Precaution against Electrostatic Discharge (ESD)
A strong electrical field, when exposed to a CMOS device, can cause destruction of the gate oxide and ultimately degrade the device operation. Steps
must be taken to stop the generation of static electricity as much as possible, and quickly dissipate it when it occurs. Environmental control must be
adequate. When it is dry, a humidifier should be used. This is recommended to avoid using insulators that can easily build up static electricity.
Semiconductor devices must be stored and transported in an anti-static container, static shielding bag or conductive material. All test and
measurement tools including work benches and floors must be grounded. The operator must also be grounded using a wrist strap. Semiconductor

devices must not be touched with bare hands. Similar precautions must be taken for printed circuit boards with mounted semiconductor devices.
2. Processing at power-on

The state of the product is undefined at the time when power is supplied. The states of internal circuits in the LS| are indeterminate and the states of
register settings and pins are undefined at the time when power is supplied. In a finished product where the reset signal is applied to the external reset
pin, the states of pins are not guaranteed from the time when power is supplied until the reset process is completed. In a similar way, the states of pins
in a product that is reset by an on-chip power-on reset function are not guaranteed from the time when power is supplied until the power reaches the

level at which resetting is specified.
3. Input of signal during power-off state

Do not input signals or an I/0 pull-up power supply while the device is powered off. The current injection that results from input of such a signal or /0
pull-up power supply may cause malfunction and the abnormal current that passes in the device at this time may cause degradation of internal

elements. Follow the guideline for input signal during power-off state as described in your product documentation.
4. Handling of unused pins

Handle unused pins in accordance with the directions given under handling of unused pins in the manual. The input pins of CMOS products are
generally in the high-impedance state. In operation with an unused pin in the open-circuit state, extra electromagnetic noise is induced in the vicinity of
the LSI, an associated shoot-through current flows internally, and malfunctions occur due to the false recognition of the pin state as an input signal

become possible.
5. Clock signals

After applying a reset, only release the reset line after the operating clock signal becomes stable. When switching the clock signal during program
execution, wait until the target clock signal is stabilized. When the clock signal is generated with an external resonator or from an external oscillator
during a reset, ensure that the reset line is only released after full stabilization of the clock signal. Additionally, when switching to a clock signal

produced with an external resonator or by an external oscillator while program execution is in progress, wait until the target clock signal is stable.
6. Voltage application waveform at input pin

Waveform distortion due to input noise or a reflected wave may cause malfunction. If the input of the CMOS device stays in the area between V.
(Max.) and Vi1 (Min.) due to noise, for example, the device may malfunction. Take care to prevent chattering noise from entering the device when the

input level is fixed, and also in the transition period when the input level passes through the area between Vi (Max.) and Vix (Min.).
7. Prohibition of access to reserved addresses

Access to reserved addresses is prohibited. The reserved addresses are provided for possible future expansion of functions. Do not access these

addresses as the correct operation of the LSl is not guaranteed.
8. Differences between products

Before changing from one product to another, for example to a product with a different part number, confirm that the change will not lead to problems.
The characteristics of a microprocessing unit or microcontroller unit products in the same group but having a different part number might differ in terms
of internal memory capacity, layout pattern, and other factors, which can affect the ranges of electrical characteristics, such as characteristic values,
operating margins, immunity to noise, and amount of radiated noise. When changing to a product with a different part number, implement a system-

evaluation test for the given product.



Notice

1. Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of semiconductor products
and application examples. You are fully responsible for the incorporation or any other use of the circuits, software, and information in the design of
your product or system. Renesas Electronics disclaims any and all liability for any losses and damages incurred by you or third parties arising from the
use of these circuits, software, or information.

2. Renesas Electronics hereby expressly disclaims any warranties against and liability for infringement or any other claims involving patents, copyrights,
or other intellectual property rights of third parties, by or arising from the use of Renesas Electronics products or technical information described in this
document, including but not limited to, the product data, drawings, charts, programs, algorithms, and application examples.

3. Nolicense, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights of Renesas Electronics
or others.

4. You shall be responsible for determining what licenses are required from any third parties, and obtaining such licenses for the lawful import, export,
manufacture, sales, utilization, distribution or other disposal of any products incorporating Renesas Electronics products, if required.

5. You shall not alter, modify, copy, or reverse engineer any Renesas Electronics product, whether in whole or in part. Renesas Electronics disclaims any
and all liability for any losses or damages incurred by you or third parties arising from such alteration, modification, copying or reverse engineering.
6. Renesas Electronics products are classified according to the following two quality grades: “Standard” and “High Quality”. The intended applications for

each Renesas Electronics product depends on the product’s quality grade, as indicated below.

"Standard": Computers; office equipment; communications equipment; test and measurement equipment; audio and visual equipment; home

electronic appliances; machine tools; personal electronic equipment; industrial robots; etc.
"High Quality": Transportation equipment (automobiles, trains, ships, etc.); traffic control (traffic lights); large-scale communication equipment; key
financial terminal systems; safety control equipment; etc.

Unless expressly designated as a high reliability product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas
Electronics document, Renesas Electronics products are not intended or authorized for use in products or systems that may pose a direct threat to
human life or bodily injury (artificial life support devices or systems; surgical implantations; etc.), or may cause serious property damage (space
system; undersea repeaters; nuclear power control systems; aircraft control systems; key plant systems; military equipment; etc.). Renesas
Electronics disclaims any and all liability for any damages or losses incurred by you or any third parties arising from the use of any Renesas
Electronics product that is inconsistent with any Renesas Electronics data sheet, user’'s manual or other Renesas Electronics document.

7. No semiconductor product is absolutely secure. Notwithstanding any security measures or features that may be implemented in Renesas Electronics
hardware or software products, Renesas Electronics shall have absolutely no liability arising out of any vulnerability or security breach, including but
not limited to any unauthorized access to or use of a Renesas Electronics product or a system that uses a Renesas Electronics product. RENESAS
ELECTRONICS DOES NOT WARRANT OR GUARANTEE THAT RENESAS ELECTRONICS PRODUCTS, OR ANY SYSTEMS CREATED USING
RENESAS ELECTRONICS PRODUCTS WILL BE INVULNERABLE OR FREE FROM CORRUPTION, ATTACK, VIRUSES, INTERFERENCE,
HACKING, DATA LOSS OR THEFT, OR OTHER SECURITY INTRUSION (“Vulnerability Issues”). RENESAS ELECTRONICS DISCLAIMS ANY AND
ALL RESPONSIBILITY OR LIABILITY ARISING FROM OR RELATED TO ANY VULNERABILITY ISSUES. FURTHERMORE, TO THE EXTENT
PERMITTED BY APPLICABLE LAW, RENESAS ELECTRONICS DISCLAIMS ANY AND ALL WARRANTIES, EXPRESS OR IMPLIED, WITH
RESPECT TO THIS DOCUMENT AND ANY RELATED OR ACCOMPANYING SOFTWARE OR HARDWARE, INCLUDING BUT NOT LIMITED TO
THE IMPLIED WARRANTIES OF MERCHANTABILITY, OR FITNESS FOR A PARTICULAR PURPOSE.

8. When using Renesas Electronics products, refer to the latest product information (data sheets, user's manuals, application notes, “General Notes for

Handling and Using Semiconductor Devices” in the reliability handbook, etc.), and ensure that usage conditions are within the ranges specified by

Renesas Electronics with respect to maximum ratings, operating power supply voltage range, heat dissipation characteristics, installation, etc.

Renesas Electronics disclaims any and all liability for any malfunctions, failure or accident arising out of the use of Renesas Electronics products

outside of such specified ranges.

Although Renesas Electronics endeavors to improve the quality and reliability of Renesas Electronics products, semiconductor products have specific

characteristics, such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Unless designated as a high reliability

product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas Electronics document, Renesas Electronics
products are not subject to radiation resistance design. You are responsible for implementing safety measures to guard against the possibility of bodily
injury, injury or damage caused by fire, and/or danger to the public in the event of a failure or malfunction of Renesas Electronics products, such as
safety design for hardware and software, including but not limited to redundancy, fire control and malfunction prevention, appropriate treatment for
aging degradation or any other appropriate measures. Because the evaluation of microcomputer software alone is very difficult and impractical, you
are responsible for evaluating the safety of the final products or systems manufactured by you.

10. Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental compatibility of each Renesas
Electronics product. You are responsible for carefully and sufficiently investigating applicable laws and regulations that regulate the inclusion or use of
controlled substances, including without limitation, the EU RoHS Directive, and using Renesas Electronics products in compliance with all these
applicable laws and regulations. Renesas Electronics disclaims any and all liability for damages or losses occurring as a result of your noncompliance
with applicable laws and regulations.

11. Renesas Electronics products and technologies shall not be used for or incorporated into any products or systems whose manufacture, use, or sale is
prohibited under any applicable domestic or foreign laws or regulations. You shall comply with any applicable export control laws and regulations
promulgated and administered by the governments of any countries asserting jurisdiction over the parties or transactions.

12. ltis the responsibility of the buyer or distributor of Renesas Electronics products, or any other party who distributes, disposes of, or otherwise sells or
transfers the product to a third party, to notify such third party in advance of the contents and conditions set forth in this document.

13. This document shall not be reprinted, reproduced or duplicated in any form, in whole or in part, without prior written consent of Renesas Electronics.

14. Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this document or Renesas
Electronics products.

(Note1) “Renesas Electronics” as used in this document means Renesas Electronics Corporation and also includes its directly or indirectly controlled
subsidiaries.
(Note2) “Renesas Electronics product(s)” means any product developed or manufactured by or for Renesas Electronics.

Corporate Headquarters
TOYOSU FORESIA, 3-2-24 Toyosu,
Koto-ku, Tokyo 135-0061, Japan

www.renesas.com

Trademarks

Renesas and the Renesas logo are trademarks of Renesas Electronics
Corporation. All trademarks and registered trademarks are the property
of their respective owners.

(Rev.5.0-1 October 2020)

Contact information

For further information on a product, technology, the most up-to-date
version of a document, or your nearest sales office, please visit:
www.renesas.com/contact/.

© 2024 Renesas Electronics Corporation. All rights reserved.
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